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IMAGE RESTORATION SOFTWARE 

AKVIS Retoucher is an efficient program for photo restoration and photo retouching.  

AKVIS Retoucher not only removes dust, scratches, stains and other defects that appear on 
damaged photos but is also able to reconstruct missing parts of a photo using the information of the 
surrounding areas.  

The work is done automatically; you only have to indicate areas to be restored, push the Run button, 
and here you are - the surface becomes smooth and imperfections disappear.  
It looks like magic when you observe the scratches vanishing before your very eyes!  

AKVIS Retoucher is also a handy tool for improving photo composition. It is possible to remove date 
stamps, small irrelevant details (wires, refuse bins, etc) and even bigger objects (i.e. people who 
fell into the shot by accident, cars in the background).  

If you need to increase the canvas size (from one side or proportionally) to bring the main object into 
focus, i.e. to center it, Retoucher will help you to extend image patterns to the blank areas of the 
canvas.  

Polygraphists will find Retoucher useful in doing the prepress processing job. They often have the 
problem of extending the borders of a layout that does not have space for cropping.  

AKVIS Retoucher saves much time by doing this quickly and efficiently!  

  

Use AKVIS Retoucher for the following purposes: 

- Restore old and damaged photos from your family archive by removing scratches, stains and 
other defects;  

- Improve the composition of your photos by removing the date stamp, distracting details (wires, 
refuse bins, etc) and by extending the photo canvas (increase the image canvas and the plug-in 
will recreate the image patterns in the blank areas);  

- Reconstruct missing parts of the photo (to restore a torn photo, in polygraphy to extend the 
borders of a layout that does not have space for cropping).  

- Remove larger and complex objects (people, cars, buildings). 

AKVIS Retoucher is your reliable tool for increasing productivity!  

   

AKVIS Retoucher is available as an independent program (standalone) and as a plugin to a photo 
editor.  
The functionality of the program depends on the license type.  

The plugin version is compatible with Adobe Photoshop, Photoshop Elements, Corel Paint Shop Pro etc. 
Check the compatibility page for more details.  
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INSTALLATION 

  

Attention! You must have administrator rights to install the program on your computer.  

Before installing the AKVIS Plugin, please make sure that the photo editor where you want to install 
the plugin, is closed.  

  

Follow the instructions to install AKVIS Retoucher in Windows.  

¡ Start the setup file akvis-retoucher-setup.exe.  

¡ Select your language and press the OK button to launch the installation process. 

¡ To continue the installation process you have to read and accept the License Agreement. 

Activate the check box "I accept the terms in the license agreement", and press Next.  

 

 

¡ To install the Plugin you should select your photo editor(s) from the list. 

If your photo editor is not in the list, activate the component  Custom Plugins Directory

and choose the folder where you keep all plugins and filters, for example, C:\My Plugins. In this 
case you should set this folder as the plugins folder in the settings of your photo editor.  

To install the Standalone version, make sure that the check-box Standalone is activated.  
To create a shortcut for the program on desktop, activate the component Shortcut on 
Desktop.  

Press the button Next.  
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¡ Press the button Install. 

 

 

¡ The installation is in progress. 
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¡ The installation is completed. 

You can subscribe to the AKVIS Newsletter. Enter your e-mail address.  

 

 

¡ Press Finish to exit Setup.  

After installation of the standalone version of Retoucher, you will see a new line in the Start menu: 
AKVIS - Retoucher and a shortcut on desktop, if during installation the component Shortcut on 
Desktop was enabled.  

After installation of the Retoucher plugin you will see a new item in the Filter (Effects) menu of your 
photo editor. For example in Photoshop: Filter -> AKVIS –> Retoucher. Please use this command to 
launch the plugin in the editor.  

Attention!  
If the plugin does not appear in the Filter, copy the 8bf file from the AKVIS folder (C:\Program 
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Files\AKVIS\Retoucher\Retoucher.8bf) into the Plugins folder of your image editor. Consult the 
tips on how to install plug-ins into Photoshop (read the installation troubleshooting guide), or 
into Paint Shop Pro Photo, or PhotoImpact. Read how to work with our plugins in GIMP or Xara 
Xtreme. If you still have problems, please write to our support team.  
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INSTALLATION 

  

Attention! You must have administrator rights to install the program on your computer.  

Before installing the AKVIS Plugin, please make sure that the photo editor where you want to install 
the plugin, is closed.  

  

Follow the instructions to install AKVIS Retoucher in Macintosh:  

¡ Open the virtual disk dmg  

- akvis-retoucher-plugin.dmg if you use Photoshop CS3-CS5,  Photoshop Elements 
6-9  
- akvis-retoucher-legacy.dmg f o r  older versions o f  Photoshop a n d  Photoshop 
Elements or other compatible image editors  
- akvis-retoucher-app.dmg to install the standalone edition of AKVIS Retoucher.  

You will see a dialog box with the License Agreement.  

 

 

¡ Read the License Agreement and press Agree, if you agree with the conditions.  

¡ Finder will open with AKVIS Retoucher application or AKVIS Retoucher PlugIn inside. 
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¡ To install the standalone version just drag the AKVIS Retoucher application into the folder 
Applications (or any other place you like). 

To install the plugin drag the entire AKVIS Retoucher PlugIn folder into the Plug-Ins folder of 
your graphic editor.  

For example, if you use Photoshop CS3 you should move the AKVIS Retoucher Plugin folder 
into: Applications/Adobe Photoshop CS3/Plug-Ins.  
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After installation of the Retoucher plugin, you will see a new item in the Filter (Effects) menu of your 
photo editor: AKVIS -> Retoucher. Please use this command to launch the plugin in the editor. For 
example, in Photoshop select in menu: Filter - AKVIS - Retoucher. 

The standalone version is run by double-click on the application.  
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HOW TO REGISTER AKVIS SOFTWARE 

  

To buy a license you should fill in the form on the product buy-page and order the software using a 
secure payment system. We offer a number of payment options (credit card, bank transfer, etc). 
When the form is filled in and the payment is made, the serial number will be sent to you within 
minutes.  

Having received the serial number you can proceed to the program registration.  

Attention! During the activation process your computer must be connected to Internet.  
If it is not possible, we offer you an alternative way (see below for Offline Activation).  

  

Follow the steps below to register the program:  

¡ Open the window About the program of AKVIS Retoucher. 
 

This window appears when you launch AKVIS Retoucher. You can also see this window by 

pressing the button  in the program. Also, Adobe Photoshop lets you call the About the 

program window right from its menu Help -> About Plug-In -> Retoucher (Photoshop -> 
About Plug-In -> Retoucher in Macintosh).  

Note that the functionality of the program depends on the license type. During the test 
period you can try all options and choose the license you like. For this select in the 
window About the program one of the offered functionality types: Home,  Deluxe or 
Business (below these is a brief descripton of the features of the license types). Your 
choice of license will affect which features are available in AKVIS Retoucher.  

The button Buy redirects you to the order page, where one can continue to choose a 
program or proceed to registration.  

If you have a license you can improve it (for example, upgrade to Home Deluxe or 
Business) any time by paying the price difference. The process is begun by pressing the 
Upgrade button (it appears instead of Buy if the program is registered).  

Please consult the comparison table for more details about license types and versions of 
the program.  
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¡ Click on Activate in the window About the program to start the activation process.  

¡ Enter your name (the program will be registered to this name).  

¡ Enter your serial number (your license key).  

¡ Choose the method of activation — either direct connection to the activation server or by mail. 

We recommend activating the program using direct connection, as it is the easiest way. At this 
step your computer must be connected to Internet.  

If you choose activation via email please put the lic-file into the folder AKVIS in Users' Shared 
(Public) Documents, and the program will be registered.  

 

¡ Press the button Activate. 

The registration is completed. 

You can start working with the photo editing software and building your unique photo collection. 
 

Note:  

In case you have chosen activation by mail, you should put the file Retoucher.lic (that you will 
receive enclosed in the e-mail) into the folder AKVIS in Users' Shared (Public) Documents:  
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¡ For Windows Vista, Windows 7: 

Users\Public\Documents\AKVIS 

¡ For Windows XP: 

Documents and Settings\All Users\Documents\AKVIS  

¡ For Mac OS X: 

Users/Shared/AKVIS  
or your Home Directory (user's folder - with your username and "home" icon) 

Do not try to open the license file (it won't work), just copy it!  

  

If your computer is not connected to Internet 

If your computer can not be connected to Internet, follow the instructions below:  

¡ Choose the option Send a request via e-mail as a method of activation. Your mailing program 
will create an activation letter with all necessary information.  

¡ Save the message to a USB stick and transfer to the computer connected to Internet.  

¡ Send the letter without changes.  

¡ You will receive a reply with a .lic file attached (Retoucher.lic).  

¡ Save the file to a USB stick and move it to your computer.

Put the file in the folder AKVIS in Users' Shared (Public) Documents (see above).  
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IMAGE RESTORATION SOFTWARE 

AKVIS Retoucher is an efficient program for photo restoration and photo retouching.  

The functionality of the program depends on the license type. During the evaluation period you can try 
all options and choose the license you like.  

   

  

  

 
Home  

(Plugin)
Home  

(Standalone)
Home Deluxe  

 (Plugin+Standalone) 
Business  

 (Plugin+Standalone) 

Purpose
non-

commercial
non-

commercial
non-commercial commercial

Edition 

  Plugin + — + + 

  Standalone — + + + 

Features 

 
Automatic 
Restoration 

+ + + + 

 
Selection and 
Retouch Tools 

+ + + + 

 
Post-Processing 
Tools 

— — + + 

  Print — + + (standalone) + (standalone) 

 
Import/Export 

*.retouch 
+ + + + 

Color Space 

  RGB + + + +

  CMYK + + + + 

  Lab + + + + 

  Grayscale + + + + 

  8 / 16 bits + + + + 

  32 bits + + + + 

Image Format 

  TIFF + + + + 

  JPEG + + + + 

  BMP + + + + 

  PNG + + + + 

  RAW + + + + 

  PSD + — + (plugin) + (plugin) 

OS 

  Windows-version + + + + 

 
Macintosh-
version 

+ + + + 

10-days trial + + + + 

Price $ 87 - € 67 $ 87 - € 67 $ 98 - € 75 $ 154 - € 118 
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WORKSPACE 

  

AKVIS Retoucher is available as a standalone program as well as a plug-in for graphics editors.  

To call the AKVIS Retoucher plug-in open an image in a graphics editor and and choose AKVIS –> 
Retoucher from the filter menu. In Adobe Photoshop go to Filter –> AKVIS –> Retoucher; in Corel 
Paint Shop Pro go to Effects –> Plugins -> AKVIS –> Retoucher; and in Corel Photo-Paint go to 
Effects –> AKVIS –> Retoucher. 

To launch the standalone version of AKVIS Retoucher, follow these instructions:  

¡ On a Windows computer: 

- Through the main menu: press Start and select from the pop-up menu the command AKVIS –
Retoucher.  

- Using the program's shortcut on the Desktop: put the cursor on the icon of the program AKVIS 
Retoucher and double-click it with the left mouse button. 

¡ On a Macintosh computer: 

- Using Finder: select the folder Applications on the side bar of the Finder window, select the 
application AKVIS Retoucher and double-click it. 

The workspace view depends on which editing mode is chosen in the Control Panel:  Express or 
Advanced.  

In Express mode, the program's interface is extremely simplified, with a minimal set of tools designed 
to quickly achieve a satisfactory result.  

  
AKVIS Retoucher Workspace (Express)  

In Advanced mode, all options and tools are available.  
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AKVIS Retoucher Workspace (Advanced)  

   

Most of the program's workspace is taken up by the Image Window, above which is the Control 
Panel.  

You can hide/show the Control Panel by clicking on the small triangle button (in the middle of the 
panel). The minimized panel will be shown when moving the cursor over it. You can use the Lock the 
Control Panel option (in the Preferences) to prevent changes and keep the panel visible all time.  

The Control Panel has the following controls:  

¡ The button  opens the home page of AKVIS Retoucher. 

 

¡ The button  (only in the standalone version) opens the image which will be edited. The hot-

keys are Ctrl+O  on Windows, +O  on Macintosh.

Right mouse click on this button displays the list of recent files. You can change the number of 
recent documents in the program's Preferences.  

¡ The button  (only in the standalone version) saves the edited image to a file. The hot-keys 

are Ctrl+S  on Windows, +S  on Macintosh.  

¡ The button  (only in the standalone version) is used to print an image. The hot-keys are 

Ctrl+P  on Windows, +P  on Macintosh.  

¡ The button  loads selected areas that have been saved to a file (.retouch). 

 

¡ The button  saves selected areas to a separate file in the .retouch format. 

 

¡ The buttons /  show/hide selected areas. 

 

¡ The button  cancels the last action. If it is pressed multiple times, it will cancel several 
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previous actions. This can also be activated with the keyboard, by pressing Ctrl+Z  on 

Windows, +Z  on Macintosh.  

¡ The button  restores an action cancelled by . 
 

An action can also be restored with the keyboard, by pressing Ctrl+Y  on Windows, +Y  on 

Macintosh.  

¡ The button  begins the restoration process. The hot-keys are Ctrl+R  on Windows, +R

on Macintosh.  

¡ The button  (only in the plug-in) applies the processing result and then closes AKVIS 

Retoucher.  

¡ The button  shows information about the program. 
 

¡ The button  opens the program's help files. The hot-key is F1 . 
 

¡ The button  opens the Preferences dialog box. 
 

  

To the left of the Image Window i s  the Toolbar. Different tools will appear, depending on the 
workspace mode Express/Advanced chosen. The tools' parameters are shown in the Settings Panel
or in a pop-up box after right-clicking in the image window.  

  

Navigate and scale the image using the Navigator. In the Navigator you can see the reduced copy 
of the image. The frame shows the part of the image that is now visible in the Image Window; the 
areas outside the frame will be shaded. Drag the frame to make other parts of the image visible. To 
move the frame, bring the cursor inside the frame, press the left mouse button and, keeping it 
pressed, move the frame in the Navigator. 

  
Navigator 

To scroll the image in the Image Window you can press the spacebar on the keyboard and drag the 
image with the left mouse button. Use the scroll wheel of the mouse to move the image up/down, by 
keeping the Ctrl  on Windows (  on Macintosh) key pressed – to the left/to the right, by keeping 

the Alt  (Option  on Mac) key pressed − scale the image. Right-click on the scroll bar to activate the 

quick navigation menu. 

Use the slider or the buttons  and , to scale the image in the Image Window. When you click on 
the  button or move the slider to the right, the image scale increases. When you click on the 
button or move the slider to the left, the image scale reduces. 

You can also change the image scale by entering a new coefficient into the scale field. The fall-down 
menu shows some frequently used coefficients. 

You can use hot-keys to change the image scale +  and Ctrl++  ( ++  on Mac) to increase the 

image scale and -  and Ctrl+-  ( +-  on Mac) to reduce the scale. 

  

Under Navigator is the Settings Panel with parameters for the algorithm and tools.  
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Under the Settings Panel you can see Hints for the parameters and buttons when you hover over 
them with the cursor. 
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HOW IT WORKS 

  

To retouch photos using AKVIS Retoucher, follow these steps: 

¡ Step 1. Start the AKVIS Retoucher standalone or a graphics editor, if you wish to use the 
AKVIS Retoucher plugin.  

¡ Step 2. Open the image, which needs to be restored or edited, from which unnecessary details 
and defects need to be removed. 

To use the plug-in:  

Select File -> Open from the graphics editor's menu or the keyboard shortcut Ctrl+O  (

+O  in Macintosh) to call the open file dialog and select the desired image file.  

- In the standalone program (using a file in RAW, TIFF, BMP, JPEG or PNG formats):  

The Select File To Open dialog box can immediately be called after opening the program 
by dragging the cursor into the Image Window and double clicking the mouse or by 

clicking  on  the  Control Panel. Also, you can drag and drop the image into the 

program's workspace.  

¡ Step 3. If you are using the AKVIS Retoucher plug-in, call it from the menu by choosing Filter 
–> AKVIS –> Retoucher in Adobe Photoshop; Effects –> Plugins -> AKVIS –> Retoucher in 
Corel Paint Shop Pro; or Effects –> AKVIS –> Retoucher in Corel Photo-Paint. 

Selections made in the graphics editor will be transferred to the plug-in.  

¡ Step 4. The first time the program starts it will be in Express mode, with a simplified interface 
and a minimal set of tools designed to quickly achieve a satisfactory result. 

 

 

AKVIS Retoucher Workspace ("Express" Mode)  

Experienced users can work in the advanced editing mode. Switch to this mode by clicking 
Advanced in the Control Panel: the interface's appearance will change, providing access to 
the full functionality of the program.  
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AKVIS Retoucher Workspace ("Advanced" Mode)  

¡ Step 5. Mark the areas of the image which need to be retouched. It might be a scratch, text, or 
a small object which needs to be removed. Selections made in the graphics editor will be 
transferred to the plug-in. 

You can use the following tools to make a selection: Selection Brush ,  Exclusion Tool , 

Eraser , Selection Bucket , and Magic Wand .  

The selected areas will be highlighted in red.  
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Defects Marked  

You can save your work on a selection to a file (in .retouch format) with the  button. You 

can then load this selection at any time by pressing the  button. 
 

¡ Step 6. When working in Advanced mode, selection areas can be processed further using the 

tools Linear Retouch  and Patch . 

More about using these tools can be learned from these examples.  

¡ Step 7. Press  to start reconstructing the image. The hot key for this operation is Ctrl+R  (

+R  on Macintosh). 

If you are not satisfied with the result, you can make correct the selection areas or adjust the 
algorithm's parameters in the Settings Panel and start processing the image again.  

The result will immediately begin to appear after processing has started. If you are sure that the 
result will not turn out as you would like, you can interrupt processing by pressing Esc  or the 

Cancel button, which is located to the right of the progress bar, then make changes to the 

parameters and start processing again by pressing .  

Note: In Advanced mode you can use Local Run  to focus more clearly on individual 

selections in the image. Press L  to quickly access this tool. Processing begins after you 

click on an individual selected area. You can work step by step, selection by selection, 
fine-tuning the parameters to restore each selection more effectively. This is useful when 
you want to remove a large, complex object. If the processing result is not entirely 

successful, it is possible to undo the change with the /  buttons and make a 

correction (for example, remove unnecessary fragments, change the selection or the 
algorithm's parameters, apply a patch, etc.)  
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Result of Automatic Processing  

¡ Step 8. Those using the Home Deluxe and Business have the opportunity to perform post-

processing with the tools Clone Stamp , Chameleon Brush , and Spot Remover . 

 

 

Post-Processing with the Clone Stamp  

¡ Step 9. Press the  button to apply the result (in the plug-in only). The AKVIS Retoucher

plug-in's window closes, and the image is returned to the graphic editor's window. 
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Result  

¡ Step 10. Save the resulting image. 

- When using the plug-in:  

Open the save file dialog File -> Save As in the graphics editor, type a file name, specify 
a file format and choose a folder, in which to save the file. 

- When using the standalone:  

Press the  button and in the Save Image dialog window, type a name for the file, 

select a format (TIFF, BMP, JPEG or PNG), and choose a folder in which to save the file.  

¡ Step 11. In the standalone version of AKVIS Retoucher it's possible to print the resulting 

image. To do this press the  button, set the printing options and press the Print button.  

¡ Step 12. Close AKVIS Retoucher.  
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TOOLBAR 

  

The Toolbar contains a group of tools used to select and retouch images. A tool's parameters can be 
adjusted in the Settings Panel, or in a pop up window, which appears after bringing the cursor into 
the image window and clicking the right mouse button.  

To draw a straight line, select a starting point by clicking the left mouse button, then, while holding 
down Shift , drag the cursor with the mouse to a new location on the image, click the left mouse 

button again and release Shift .  I f  Shift  is not released, a new line will be drawn to each point 

where the left mouse button is clicked.  

The tools are divided into four sets. Different tools are visible, depending on the workspace mode 
Express/Advanced chosen.  

   

Selection Tools:  

¡ The Selection Brush  is used to highlight areas and details that need to be retouched. The 

transparency of lines made with the brush can be changed in the Preferences dialog. Press B

to quickly access this tool. 

If the Keep Exclusion Area is activated, the brush can not draw in excluded areas.  

¡ The Exclusion Tool  is used to protect areas. Parts of the image marked by this tool will be 

excluded from the area used for calculation. You can use this tool to mark areas adjacent to a 
selection to prevent them from being cloned. 

If the Keep Selection check box is activated, the tool can not draw in selected areas.  

  

Original Image Selection

  

Area to be excluded is marked Area is excluded from reconstruction
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¡ The Eraser  erases lines. Press E  to quickly access this tool. The following modes can be 

selected: 

- erase all lines;  
- erase only selection area; 
- erase only exclusion area. 

¡ The Selection Bucket  fills an area outlined with the Selection Brush  (useful for 

selecting large areas).  

¡ The Magic Wand  selects all pixels of the same color. When the value of Tolerance is 

increased, more colors are included in the selected area. 

If the Contiguous Mode check box is activated, only adjacent pixels of the same color are 
selected. If it is deactivated, all pixels the same color throughout the image will be selected. 
This tool is useful for selecting one color objects, text, etc.  

   

Manual Processing Tools:  

¡ Linear Retouch  allows you to restore the background in a specified direction: for example, 

to align the junction of areas or preserve the smooth edges of an object. Lines should be drawn 
as long as possible, into the red zone or across it. 

Parameters:  

Gradient. If this check-box is activated, areas between the beginning and the end of the 
line will be restored evenly, with a smooth transition between one part of the image and 
another. If this is not the result you want, deactivate the check box.  

  

Result without using the exclusion tool Result when exclusion tool is used

  

Original Image
Linear Retouch  

(Smooth Transition)
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Zone of Influence affects the width of the area which is restored. The higher the value, 
the wider the restored area will be. 

Search Distance affects the size of the area from which fragments are taken, which are 
used to restore along a line. A large value increases processing time and may lead to the 
capture of unwanted fragments. 

  

Restoration from left to right  

('Gradient' Check Box Not Activated)

Restoration from right to left  

('Gradient' Check Box Not Activated)

   

Original Image Selection
Result without  

Linear Retouch

   

Zone of Influence = 2 Zone of Influence = 8
Result using  

Linear Retouch

  

Original Image Selection
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¡ Patch  restores by copying similar square fragments from other parts of the image. To apply 

a patch, bring the cursor over the appropriate area, hold down the left mouse button, then drag 
the clone into the red area. 

Parameters:  

Patch Size affects the size of the patch used in restoration. 

¡ Local Run  is used to process selected areas of the image individually. Processing begins by 

clicking on a selected area. You can focus more clearly on individual selections, fine-tuning the 
parameters to restore each selection more effectively. Press L  to quickly access this tool.  

   

Post-Processing Tools (available for Home Deluxe and Business licenses):  

¡ Spot Remover  removes small imperfections on an image: stains, dust, etc. You can also use 

it to retouch portraits, it looks like it "heals" skin problems. Just click with the tool on the defect. 
Press O  to quickly access this tool.  

¡ Clone Stamp  copies parts of an image from one area to another while preserving the cloned 

area's original color palette, shadows, textures, lighting, and other characteristics. Press S  to 

  

Search Distance = 1 Search Distance = 5

  

Result without  

Linear Retouch

Result with  

Linear Retouch

  

Patch Size = 15 Patch Size = 50
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quickly access this tool.  

¡ Chameleon Brush  copies parts of an image from one area to another, while taking into 

account the color palette, shadows, textures, lighting, and other characteristics of the 
background, onto which the clone is placed. Unlike the Clone Stamp, this tool preserves the 
texture of the image. Press H  to quickly access this tool. 

You can change the Size of the tools. For Clone Stamp and Chameleon Brush you can also 
select the cloning method (Aligned on/off).  

Also, for Clone Stamp it's possible to adjust Hardness (blurriness of the fragment's edges) and 
to mirror a clone horizontally and/or vertically:  

Activating the Flip Horizontal check-box allows a clone to be mirrored along the standing axis, 
i.e. interchanging the left and right sides.  

Activating the Flip Vertical check-box mirrors a clone by turning the image upside down.  

How to work with Clone Stamp and Chameleon Brush:  

Select an area to be cloned by holding down Alt  on Windows or Option  on Macintosh.  

To remove a part of the clone, press the Ctrl -key on the keyboard (  on Macintosh) and, 

keeping it pressed, draw over the area. 

   

Additional Tools:  

¡ This  button activates the Hand tool, which allows you to scroll the image when it does not 

fit within Image Window at the desired scale. To use it click on the button, bring the cursor 
over the image, and while keeping the left mouse button pressed move in the desired direction.  

¡ This  button activates the Zoom tool, which changes the image's scale. To zoom in left click 

on the image. To zoom out right click on the image. Press Z  to quickly access this tool.  
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THE ALGORITHM'S PARAMETERS 

  

AKVIS Retoucher reconstructs missing parts of a photo by using information from surrounding areas 
(we'll call them samples).  

You can adjust the algorithm's parameters in the Settings Panel:  

¡ Sample Size (0-16) affects the size of sample fragments. At higher values of this parameter, 
more of the background's texture is preserved, but image detail appears coarser. 

¡ Sample Number (1–50) affects the number of sample fragments taken from surrounding areas 
and used in reconstruction. They are chosen randomly. At higher values, more of the 
background's texture is reconstructed, but processing time increases. 

   

Original Image Sample Size = 3 Sample Size = 14

  

Original Image Selection

  

Sample Number = 1 Sample Number = 50
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¡ Search Radius (16-250) affects the size of the area used to search for sample fragments used 
in reconstruction. The higher the value, the longer reconstruction takes. If the radius is too 
large, sample fragments from remote areas of the image could be chosen, which would not be 
suitable in reconstruction. 

¡ Smoothing Check Box. This mode reduces the transition between fragment edges. It's helpful if 
edges are similar in texture but not in color. If the check box is deactivated there is no 
alignment. 

¡ Fast Processing Check Box. When this check box is activated, processing speed is increased by 
simplifying the original image. This is useful in most cases and allows you to quickly get a good 
result. 

  

Original Image Selection

  

Search Radius = 30 Search Radius = 220

   

Original Image With Selection 'Smoothing' Check Box Deactivated Reconstruction and Smoothing

AKVIS Retoucher

 29 / 55



  

  

Original Image Selection

  

Result After Full Processing Result After Fast Processing

   

Original Image With Selection Result After Full Processing Result After Fast Processing
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PREFERENCES 

  

Open the Preferences dialog by pressing on . The dialog window looks like this:  

  

¡ Language. To switch the interface language, select another language from the drop down list.  

¡ Initial Scale. This parameter affects how the image will appear in the program when you first 
open it. The parameter can have one of two values: 

- If the parameter is set to Fit to View, the image will be scaled so that it will fit 
completely within the Image Window;  

- If the parameter is set to 100% the image will not be scaled. In most cases, when an 
image is opened at 100% scale the entire image will not fit within the Image Window.  

¡ Selection Area: Opacity. The parameter allows you to adjust the opacity of the color used 
when a selection is created.  

¡ Recent Files (available only in the standalone version). The number of recent documents. The 

list of the recent files, sorted by time, become visible by right mouse clicking on . Maximum: 

30 files.  

¡ Use OS File Dialog check-box. You can check this option if you want to use the System 
Open/Save Dialog. By default, the AKVIS File Dialog is used.  

¡ Lock the Control Panel check-box. It disables the possibility to hide/show the top panel. If the 
check-box is selected the panel is always visible.  

To apply changes made in the Preferences window press ОК.  

If necessary, you can return to the default settings by pressing Default.  
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PRINT IMAGES IN AKVIS RETOUCHER 

  

The standalone version of AKVIS Retoucher lets you print the image. Just press the button  on 

the Control Panel. The Print dialog box will be opened.  

  
Print dialog box in AKVIS Retoucher  

The left part of the Print dialog box is the preview area where the current position of the image on 
the page is shown. On the right side of the dialog window the following print settings can be adjusted: 

¡ Printer. If your computer is connected to a local network with many printers or if it is 
connected to many output devices itself, you will need to choose one of the available printers to 
print your image. Choose the desired print resolution from the Print Resolution drop-down list. 
The available choices will be based on those available for the printer you have chosen.  

¡ Orientation of the printed image. There are two types of orientation available - Album and 
Portrait.  Album corresponds to the horizontal page orientation (width is greater than height), 
while Portrait - corresponds to the vertical orientation of the paper.  

¡ Print Size. To change the size of the printed image, adjust the parameters Scale,  Width, 
Height and Fit to Page. These parameters have no effect on the image itself, just on the 
printed version. You can change the size of the printed image by entering any value in % (any 
value less than 100% will result in a smaller print size, and any value larger than 100% - will 
result in a larger print size), or by entering new values in Width and Height. If you want the 
size of the image to be adjusted to the paper size, then just select Fit to Page.  

¡ Move To. Choose the position of the image on the page by clicking on one of the the eight 
arrows. 

The size of the printed image and its orientation can also be selected manually. A frame with 
markers is displayed around the image in the preview window. To change the size of the image 
move the cursor to one of the corner markers or to a side (the cursor changes in shape to a 
double sided arrow) and drag the marker or side. To change the position of the image on the 
page, bring the cursor over the image, press the left mouse button, and move the cursor.  

Clicking the Page Setup button opens a dialog window in which you can choose the size of the paper 
and its orientation, as well as the print margins. To print an image with the chosen parameters, press 
the Print button. To cancel and close the printing dialog window press the Cancel button.  
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REMOVING LARGE OBJECTS 

  

AKVIS Retoucher offers two types of processing for photographs: retouching (eliminating defects and 
scratches) and removing objects. The sequence of actions involved in both cases is different: 
retouching is mainly performed through automatic processing, while when removing large objects, part 
of the work is done manually and requires learning how to use the Linear Retouch  and Patch 

tools.  

The following are general suggestions for removing a large object. At any stage you can undo changes 

with the /  buttons, make adjustments and then process the image again.  

¡ Step 1. Open the image in AKVIS Retoucher, and switch to Advanced mode. 

 

 

AKVIS Retoucher Workspace  

¡ Step 2. Select the object which you want to remove (along with any shadows or reflections). 
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Selecting the Object  

¡ Step 3. Use the Linear Retouch  tool to restore the main lines of the background through 

the image. Linear Retouch allows you to restore the background in a specified direction: for 
example, to align the junction of areas or preserve the smooth edges of an object. It is also 
useful for breaking a large object into smaller pieces, making it easier to remove. 

 

 

Direction of Lines  

Draw lines as long as possible, through the red zone and beyond it. Once a line is drawn, the 
fragments along it are immediately restored:  
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After Using Linear Retouch  

¡ Step 4. Use the Patch  to fill in the red zone with samples from the image which are the best 

suited for restoring the background. 

Placing more patches in heterogeneous areas produces a better result, such as for an area 
covered in grass. Fewer samples would need to be placed in a homogeneous area, such as the 
sky.  

 

   

Select a fragment for the patch Place the fragment in the red zone Result 
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Filling with Patches  

It's better to use the Linear Retouch tool  over the walkway, since it has a pronounced 

banded pattern.  

 

 

Using Linear Retouch on the Walkway  

The area around the path now looks like this:  
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After Linear Retouch Has Been Applied  

¡ Step 5. Use the Linear Retouch  to connect all patches and divide the selection into 

homogeneous fragments. You can draw small lines through fragments. 

 

 

Dividing Fragments  

¡ Step 6. Use Local Run  to restore individual fragments, starting with those at the edges of 

the object to be removed. Processing is started by clicking on a fragment. Parameters for each 
selection can be adjusted in the Settings Panel. 

Why process the selection in fragments? When full processing (with the  button) is applied, all 

of the fragments are processed at the same time. It's a long process in which samples are taken 
from areas adjacent to the selection, so they may not be best suited for properly restoring the 
entire selection. Therefore, areas processed in this manner will tend to appear rougher.  

When you use the Local Run tool, samples are taken not only from the original background but 
also from newly restored areas adjacent to the fragment, allowing the background to be restored 
more gradually and accurately. Each fragment can be processed selection by selection. 
Therefore, the overall result depends on the order in which selections are processed.  
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Processing Selection by Selection  

If a fragment was processed unsucessfully, press the  button and readjust the settings (or 

add more patches). If it is difficult to find suitable parts of the background for patches, you can 
select from restored areas.  

 

 

Adding Patches  

This is the result after all areas have been processed.  
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After Using Local Run  

¡ Step 7. Perform post-processing on the image, to remove seams and other irregularities in 

restored areas. This can easily be done with the Clone Stamp  and Chameleon Brush 

(which are available in the Home Deluxe and Business versions of the program). 

If your version does not have these tools, you can select any remaining defects as done in 
previous steps and process the image again.  

Now the figures have been removed from the picture.  

 

 

Restoration Result  

¡ Step 8. Save the resulting image.  
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RESTORATION OF AN OLD FAMILY PHOTO 

  

Take a look at the old scanned photo and the result of restoration in AKVIS Retoucher.  

This old photo is considerably damaged. We will restore this photo in two stages. At the first stage we 
will apply automatic processing in AKVIS Retoucher that will perform the preliminary work of removing 
most scratches and making big scratches less visible. At the second stage we will retouch the 
remaining defects with the post-processing retouching tools.  

 

 

¡ Selection of the damaged area

First of all, we should paint over all scratches and the inscription on the child's shoulder using 

the Selection Brush  in AKVIS Retoucher.  

We do not paint over the fold line that crosses the photo as it goes across the faces of the 
mother and child and it can be retouched better manually.  
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¡ Automatic restoration 

Press the  button to start the photo restoration process. The program reconstructs selected 

parts of a photo by using information from surrounding areas.  

When Retoucher is through with its job, the photo will look like this:  

 

 

  

¡ Retouching tools 

Now you can proceed to the second stage of restoration and retouch minor defects with the 

post-processing tools: Clone Stamp  and Chameleon Brush . Both are available only in 

Home Deluxe and Business versions of Retoucher.  

Alternatively, you can remove small defects using AKVIS MiltiBrush which offers these and 
some other useful retouching tools.  
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The original picture is taken from the School of Art, Design and Art History site — art.sdsu.edu . 
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LIONESS IN A CAGE: REMOVE IRON RODS 

  

AKVIS Retoucher is efficient for photo restoration tasks. It can be applied to restore old damaged 
photos or to remove a date stamp or an unwanted object, like a finger that covered the lens when 
shooting or an irrelevant object that spoils the shot.  

This tutorial illustrates the second case: we will use AKVIS tools to remove the cage rods from the 
photo below.  

 

 

¡ Step 1. Open the image in AKVIS Retoucher.  Select the bars using the Selection Brush . 

Don't forget to also select their shadows. 
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¡ Step 2. After starting the retouching process by pressing , the red area (along with the 

cage's bars) disappears. The image will appear like this: 

 

 

¡ Step 3. The joint at the bottom does not look correct. The image needs to be processed more 

accurately. Therefore, press  to cancel the previous action. Switch to Advanced and 

choose the Linear Retouch  tool. Draw a few strokes over places where you want to restore 

lines: 

 

 

Process the image by pressing . 
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¡ Step 4. The processing result, of course, is not ideal: Retoucher failed to restore the nose, 

which was almost completely obscured by the cage's bars. We can use the Clone Stamp 

tool to deal with the incongruities of the fur. 

The Clone Stamp repairs damaged areas using cloned fragments from other parts of the photo. 
Choose a cloning sample by left-clicking on a suitable area while holding Alt  (Option  in 

Macintosh). To apply the clone sample, bring the cursor over the area you want to repair and 
left click.  

Look at this picture — the cage is gone, the lioness is free, and she even looks happier.  
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RESTORATION OF A DAGUERREOTYPE 

  

The photo has been sent to us by Oleg Rakhimov. It is a daguerreotype of his relative made in 1893. 

¡ Step 1. Open the photograph in AKVIS Retoucher. We can say, that this daguerreotype was 
wisely preserved up to our times, so it will require very little retouching: just hiding a few 
scratches and "growing" the corners. 

 

 

¡ Step 2. Before the photo can be retouched, all of its damaged areas should be selected. First 
scale the image, so that it will be easier to see even the smallest scratches, and select them

using the Selection Brush . Gradually paint over the scratches and missing areas of the 

picture. 
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¡ Step 3. Press  to begin the retouching process, and it will become apparent that the red 

highlighted areas disappear, along with the damage beneath them. 

Here is the result, after the retouching process is complete.  
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AKVIS PROGRAMS 

  

AKVIS Retoucher — Image Restoration Software   

AKVIS Retoucher is an efficient program for photo restoration and photo retouching.  

Retoucher removes dust, scratches, stains and other defects that appear on damaged photos. It 
reconstructs the missing parts of the photo using the information of the surrounding areas. more...  

 

  

AKVIS Chameleon — Photo Collage Creation   

AKVIS Chameleon is a fun to use tool for photo collage creation. It makes the process easy and 
entertaining. The tool is very easy to handle as it does not require precise selection of objects.  

Create your own photo collages! more...  

 

  

AKVIS MultiBrush — Photo Retouching Made Easy   

AKVIS MultiBrush makes it easy to retouch photos and enhance portraits. Featuring a collection of 
healing and enhancement brushes, stamping and drawing tools, AKVIS MultiBrush helps artists, 
photographers and home users to perform portrait enhancement, retouch image flaws and remove 
unwanted objects from digital pictures, paint funny details on a photo or create an image from 
scratch. The program offers two sets of tools — Standard and Artistic Brushes. more...  
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AKVIS Enhancer — Photo Enhancement Software   

AKVIS Enhancer is image enhancement software that improves detail on an image, no matter what was 
the cause of the unsharpness. The program detects detail in underexposed, overexposed and mid tone 
areas of a photo with uneven exposure.  
Enhancer improves every part of the photo. more...  

 

  

AKVIS Coloriage — Add Color to Black and White Photos   

AKVIS Coloriage allows colorizing B&W photos and replacing colors in color photos. 

Just indicate the desired colors by the stroke of the brush; the program does the rest of the work: 
recognizes the object's border and tailors the new color to the grayscale tones of the initial picture. 
more...  

AKVIS Retoucher

 49 / 55

http://akvis.com/en/multibrush/index.php?ref=help
http://akvis.com/en/enhancer/index.php?ref=help
http://akvis.com/en/enhancer/index.php?ref=help
http://akvis.com/en/enhancer/index.php?ref=help
http://akvis.com/en/coloriage/index.php?ref=help
http://akvis.com/en/coloriage/index.php?ref=help
http://akvis.com/en/coloriage/index.php?ref=help


 

  

AKVIS Noise Buster — Noise Reduction Software   

AKVIS Noise Buster is software for noise suppression on digital and scanned images.  

Digital noise can be seen as artifacts and random red and blue pixels that compromise the smoothness 
of a photo. The program is efficient against both color and luminance noise. more...  

 

  

AKVIS Sketch — Convert a Photo to a Pencil Sketch   

AKVIS Sketch converts digital photos to amazing pencil sketches and watercolor drawings.  

Now you do not need to handle a pencil to feel like an artist. All you need to create your original work 
of art is good taste and AKVIS Sketch. more...  
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AKVIS Decorator — Resurface and Recolor   

The Decorator plug-in lets you change the surface of an object in a realistic manner.  

The program puts on a texture keeping the volume of an object, following its folds and creases. The 
new pattern looks absolutely natural and makes you see things differently. Recoloring is also made 
easy. more...  

 

  

AKVIS LightShop — Amazing Light Effects   

AKVIS LightShop lets you create an infinite number of astounding light effects!  

A light effect draws attention and animates any photo. It can make it look more natural (by adding 
reflections on shiny objects) or on the contrary - add a bit of magic and fantasy. more...  
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AKVIS ArtSuite — Apply Effects to Your Photos!   

AKVIS ArtSuite is an impressive collection of versatile frames and effects for photos. ArtSuite contains 
many templates and texture samples that can be used to create a virtually limitless variety of options 
for generating frames. 

Decorate a photo to give it an original and festive look! more...  

 

  

AKVIS SmartMask — Save Time on Complex Selections   

AKVIS SmartMask is an efficient masking tool that saves you time on complex selections and is fun to 
use.  

Never before has selection been so easy! The plugin makes the selection you want - understanding 
where the borders of the object end. more...  

 

  

AKVIS Magnifier — Change Image Size without Quality Loss   

AKVIS Magnifier allows resizing images without loss in quality.  
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Whether creating poster-size images, adding resolution for printing an enlargement, or reducing image 
size, AKVIS Magnifier will make your prints look sharper and better defined. more...  

 

  

AKVIS ArtWork — Discover the World of Painting!   

AKVIS ArtWork is photo to painting software, it is designed to imitate different painting techniques 
(Oil, Watercolor, Comics, Pen&Ink, Linocut). ArtWork helps you to create a piece of art out of any 
digital photo.  

Create an oil portrait of your friend, a landscape painting or a still life picture. Express yourself in new 
genres! more...  

 

  

AKVIS NatureArt — Bring Nature To Your Photos   

AKVIS NatureArt is an excellent tool for imitating the magnificence of natural phenomena on your 
digital photos. Nature effects have an impact on our mood and it can be used to strengthen the 
impression from a picture.  

Add dramatic nature effects to your photo, change the weather on it! more...  
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AKVIS Refocus — Improve Your Blurred Photos   

AKVIS Refocus improves sharpness of out of focus images. The program can process the entire photo 
or bring into focus only the selected part to make the subject stand out against the background.  

Even if a photo looks sharp enough, there is always room for improvement. To create a special effect 
and draw attention to certain details, you can use selective focus. more...  

 

  

AKVIS HDRFactory — Brighter than Reality!   

AKVIS HDRFactory lets you create an HDR image from a series of shots or from one single photo. The 
program can also be used for photo correction.  

AKVIS HDRFactory brings life and color to your photos! more...  
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